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CHAPTER 1

Introduction
This version of Doc-To-Help contains several new features and enhancements.
For more information about each feature discussed in this manual, open the online Help and
refer to the "What's New in this Version" topic. Links are provided in each new feature
description, taking you to topics that contain additional information and steps.
This chapter discusses the following:

Summary of New Features
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Summary of New Features
Following are the new features introduced in this version of Doc-To-Help.
Feature

What's New?

For More…

Upgrading Old

Prompt to upgrade to new version of Doc-To-Help

See "Upgrading Old

Projects—Tem-

Prompt to update old source templates

Projects—Tem-

plates
Replaced

DOT templates now either DOTX or DOTM

plates Replaced" on
page 9.

Minor redesign in updated templates
Cover Image

Can set cover image for Manual targets in Help Targets

See "Cover Image

for a Manual

dialog

for a Manual Target"

Target

Based on a bookmark named "CoverImage"

on page 13.

Doc to DocX

Lets you upgrade older Word documents (DOC files) in

See "Doc to DocX

Conversion

your project to the newer DOCX format

Conversion" on
page 19.

Fancy Tem-

Two new templates added

See "Fancy Tem-

plates

Intended to help you produce print-based output that has

plates" on page 21.

a fancier look than the other templates
Link to

In Link dialog, can now see all project topics listed

See "Link to

Deleted Top-

Deleted topics shown with red X icon

Deleted Topics" on

ics

Can create links to such deleted topics without first

page 25.

rebuilding a target
Multimedia

Ability to embed more than just Flash movies

See "Multimedia

Enhancements

Can add HTML5, Windows Media, QuickTime,

Enhancements" on

YouTube, and Vimeo

page 29.
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Feature

What's New?

For More…

Page Ori-

New property called "Section orientation" now available

See "Page Ori-

entation in a

for Manual targets

entation in a Manual

Manual Target

Lets you specify a portrait or landscape configuration for

Target" on page 37.

pages within a given section break in a Word document
Can set section configuration on a paragraph style or an
entire Manual target
Variables—

Two new types of variables available

See "Variables—

Date/Time and

Date/time variables get values either from current sys-

Date/Time and Ver-

Version

tem date/time, or from file date/time attributes

sion" on page 43.

Version variables let you create reusable numerical text
in four available formats; numbers increment when you
build
Removal of

Certain features removed; makes Doc-To-Help more

See "Removal of

Features

streamlined for authors who want to use newer versions

Features" on page

of Microsoft Word and generate output in more modern

51.

(rather than outdated) formats
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CHAPTER 2

Upgrading Old Projects—Templates
Replaced
If you open an old Doc-To-Help project, a prompt is shown, asking if you want to upgrade to
the project to the new version, as well as make a backup.

If you select to create a backup, it will be created at the same level as the project folder.

Upgrading your old project is necessary if you want to use the new version of Doc-To-Help
because doing so makes changes to removed target settings.
In addition to the previous prompt, if your project references source templates with the C1H
prefix, you will also see a prompt asking if you want to update all of your preinstalled source
templates to the new version. In previous Doc-To-Help upgrades, this would happen automatically. The new version uses D2H as the prefix for template names, and if you had a previous version of Doc-To-Help installed on your computer, your previous C1H templates will
remain available and unchanged for your reference.

Doc-To-Help has replaced the old Word 2007 DOT template files with newer Word 2007 templates (mostly
DOTM files—the "M" means they may contain macros) that have updated Doc-To-Help ribbons. You may
notice some minor redesigning in the templates.
Update If you choose to update your source templates, your project documents will point to the new
templates that have the D2H prefix. This means you will see the updated ribbons (e.g., the old
"Flash" button now says "Multimedia") in your source template and documents. Any changes
(styles, etc.) that you've made in the old source templates will not be transferred into the new templates; you will need to do that manually.
Do Not Update If you do not update your source templates, your project will continue to use the old
templates that have the C1H prefix along with any styling or changes you have made in those templates. This also means that you will see the old Doc-To-Help ribbons from previous versions.
Note: No changes are made to target templates.

Note: You can update your source documents manually anytime by opening the document and
pointing to a different template via the Options dialog. See the online Help or the Making It Look
Good Guide.

Note: Because DOT templates with the C1H prefix are no longer installed with Doc-To-Help, if
you do not update your source templates you will need to copy these templates to any new
machine you use.

10

Table of Old and New Templates
Old Template
C1H_HTML.dot

New Template
D2H_HTML.dotx
Note: This is the default template for HTML-based targets in
new projects.

C1H_NOMARGIN.dot

D2H_NOMARGIN.dotm
Note: This is the default source template in new projects.

C1H_NOMARGIN_A4.dot

D2H_NOMARGIN_A4.dotm

C1H_NORM.dot

D2H_NORM.dotm

C1H_NORM_A4.dot

D2H_NORM_A4.dotm

C1H_PRNOMARGIN.dot

D2H_PRNOMARGIN.dotm
Note: This is the default target template in new projects.

C1H_PRNOMARGIN_A4.-

D2H_PRNOMARGIN_A4.dotm

dot
C1H_PRNORM.dot

D2H_PRNORM.dotm

C1H_PRNORM_A4.dot

D2H_PRNORM_A4.dotm

C1H_PRSIDE.dot

D2H_PRSIDE.dotm

C1H_PRSIDE_A4.dot

D2H_PRSIDE_A4.dotm

C1H_PRSMAL.dot

D2H_PRSMAL.dotm

C1H_PRSMAL_A4.dot

D2H_PRSMAL_A4.dotm
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Old Template

New Template

C1H_sandcastle_src.dot

D2H_sandcastle_src.dotm

C1H_SIDE.dot

D2H_SIDE.dotm

C1H_SIDE_A4.dot

D2H_SIDE_A4.dotm

C1H_SMAL.dot

D2H_SMAL.dotm

C1H_SMAL_A4.dot

D2H_SMAL_A4.dotm
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CHAPTER 3

Cover Image for a Manual Target
For the Manual target type, you can specify a cover image in the Help Targets dialog, as
opposed to embedding it in the template file. This is simply an easier, more convenient
option and allows you to specify a cover image for specific targets.

EXA MPLE
Let's say your target template initially looks like this, with Doc-To-Help's default cover image
embedded on the first page.
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You want to replace this image with your own. Instead of editing the template, replacing the Doc-ToHelp image, you open the Help Targets dialog and point to your own image.

After you generate the output, your image replaces the default Doc-To-Help cover image.

CHAPTER 3│What's New Guide

15

16

HOW TO SET A COVER IMAGE FOR A MANUAL TARGET
1. (Recommended) Add the desired image to your project. (Typically, images are stored in the Media
folder.)
2. In Doc-To-Help, open the Home ribbon, and at the bottom of the Target group click

. The Help

Targets dialog opens.
3. On the left side of the dialog, select the Manual target.
4. In the Build section, specify the image in the Cover image field.
In most cases, you will click

and select an image within your project, which produces a relative

path to that image (e.g., Media\MyImage.png).
Note: It is also possible to use an absolute path and point to an external image, but a relative path to an image within the project is recommended.

5. Click OK.
COVER IMAGE BOOKMARK
This feature is based on a bookmark named "CoverImage." All source and Manual target templates
provided by Doc-To-Help have this bookmark, and it is placed by default on the cover image at the beginning of the template. However, if you specify a different image in the Help Targets dialog, it will replace the
default cover image that is embedded in the target template.
To define a new location for the cover image, you can edit the template, inserting a bookmark named
"CoverImage" somewhere before the "ChapterHeading" bookmark (if it exists). Otherwise, the image will
be inserted at the beginning of the document.
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CHAPTER 4

Doc to DocX Conversion
There is a new option called "Convert Doc to DocX" found in File>Tools.

This lets you upgrade older Word documents (DOC files) in your project to the newer DOCX format. The
DOC format is from Word 2003 and older versions of Word. The DOCX format—an open standard format
based on XML—was introduced in Microsoft Office 2007.
HOW TO CONVERT DOC FILES TO DOCX
1. Open a Doc-To-Help project that contains at least one document with a DOC extension.
2. Close all Word documents from your project that are open.
3. In Doc-To-Help, select File>Tools>Convert Doc to DocX.
4. You will see a prompt to start the operation; click the appropriate button to begin the conversion. The
prompt message depends on whether a project is shared or not. For shared (team) projects, you
need to check out the project.
After a successful conversion, all documents in the project will be DOCX, and all links in all Word
documents will be updated appropriately.

Note: If any error occurs while converting documents, Doc-To-Help attempts to restore
everything (documents and the project) to the initial state (before starting the conversion).
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CHAPTER 5

Fancy Templates
In addition to changes to templates, there are a couple of new templates available:
D2H_FANCY This is the source template.
D2H_PRFANCY This is the complementary target template.
These templates are intended to help you produce print-based output that has a fancier look
than the other templates. This includes color, an image placed behind the text on the title
page, an image placed behind the text in the headers, and a decorative image in the footers.
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CHAPTER 6

Link to Deleted Topics
In the Link dialog, you can now see all project topics listed. If a particular topic has been
deleted as a result of the latest build (e.g., it was conditioned out of the target), it will be listed with a red X icon.
You now have the ability to create links to such deleted topics without first rebuilding a target that is conditioned to include it.

EXA MPLE
Let's say you place a condition on a topic called "Review the User Interface" so that it is included
only in a Manual target. When you build a NetHelp target, that topic is excluded from the output, and
a red X is shown next to it in the Topics window.

Then let's say you are working in a source document and you begin to insert a link. In the Link dialog, you can see that the Review the User Interface topic has been removed as a result of the most
recent build. But you are still able to select this topic when linking to it, in anticipation of building the
Manual target in the near future (where that topic will be included).
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CHAPTER 7

Multimedia Enhancements
In previous versions, there was an option in the Doc-To-Help ribbon in Word source documents that let you insert Flash videos. This option has been renamed "Multimedia" and
enhanced to include more types of video.

SUPPORTED MULTIMEDIA TYPES
In addition to Flash movies, you can now insert the following types of multimedia:
HTML5 Videos
Windows Media Files
QuickTime Movies
YouTube Videos
Vimeo Videos

DEFAULT SIZES
Following are the default sizes of videos when they are inserted:
YouTube/Vimeo 560x315 pixels
Flash Doc-To-Help uses size from SWF file
QuickTime and HTML5 Width and height not set by default
HOW TO INSERT MULTIMEDIA
1. In the Word source document, place your cursor where you want to insert the multimedia element.
2. On the Doc-To-Help ribbon, click the Multimedia button. The Insert Multimedia dialog opens.
3. In the Source URL field, do one of the following:
If you want to embed a YouTube or Vimeo video, paste the URL in the field.
If you want to select a multimedia file, click

. Then in the Open dialog, find and select the

file. If the file is located outside the project folder, there will be a message to copy the file to
the project folder.
4. (Optional) In the Alternative text field, you can type alternate text to display when the video is not
available, such as when a disabled individual is using a screen reader.
5. (Optional) Complete the rest of the options as necessary. The options shown depend on the type of
movie file you are inserting.
FLASH OPTIONS
Size Specify the width and/or height in pixels or percentage.
Movie
Quality
Low Favors playback speed over appearance and never uses anti-aliasing.
Auto Low Emphasizes speed at first but improves appearance whenever possible.
Playback begins with anti-aliasing turned off. If the Flash Player detects that the processor can handle it, anti-aliasing is turned on.
Auto High Emphasizes playback speed and appearance equally at first but sacrifices appearance for playback speed if necessary. Playback begins with anti-aliasing turned on. If the actual frame rate drops below the specified frame rate, anti-
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aliasing is turned off to improve playback speed. Use this setting to emulate the
View>Antialias setting in Flash.
Medium Applies some anti-aliasing and does not smooth bitmaps. It produces a better quality than the Low setting, but lower quality than the High setting.
High Favors appearance over playback speed and always applies anti-aliasing. If
the movie does not contain animation, bitmaps are smoothed; if the movie has animation, bitmaps are not smoothed.
Best Provides the best display quality and does not consider playback speed. All
output is anti-aliased and all bitmaps are smoothed.
Scale
Default Makes the entire movie visible in the specified area without distortion, while
maintaining the original aspect ratio of the movie. Borders may appear on two sides
of the movie.
No border Scales the movie to fill the specified area, without distortion but possibly
with some cropping, while maintaining the original aspect ratio of the movie.
Exact fit Makes the entire movie visible in the specified area without trying to preserve the original aspect ratio. Distortion may occur.
Alignment Select where you want the video to be displayed within the container area
(e.g., Left, Right, Bottom, Bottom Right).
Playback
Auto Play Select this option if you want the video to automatically begin playing when
the topic displays. Otherwise, the user must click the Play button to start the movie.
Loop Select this option if you want the movie to play repeatedly.
Show Menu Select this option if you want to display the full menu, allowing the user a
variety of options to enhance or control playback. If you do not select this option, the
menu contains only the Settings option and the About Flash option.
Enable SWLiveConnect Select this option to specify whether the browser should start
Java when loading the Flash Player for the first time.
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WINDOWS MEDIA OPTIONS
Size Specify the width and/or height in pixels or percentage.
Player Controls Select an option for displaying the player controls (e.g., Play, Pause,
Volume).
None Does not display any player controls.
Mini Displays only some of the player controls (Play, Pause, Stop, Mute, Volume).
Full Displays all of the available player controls.
Invisible Hides the movie entirely, while still playing the audio. If you select this option,
you might want to resize the container square in your topic so that it does not take up so
much space in the output. The user will simply see blank space where the container
exists.
Playback
Auto Start Select this option if you want the video to automatically begin playing when
the topic displays. Otherwise, the user must click the Play button to start the movie.
Full Screen Select this option to display the movie using the entire screen.
Stretch to Fit Select this option to automatically resize the movie so that it exactly
matches the size of the container area.
Play Count Enter the number of times you want the video to repeat.
Audio Select options for the sound (mute, volume level, balance).

32

QUICKTIME AND HTML5 OPTIONS
Size Specify the width and/or height in pixels or percentage.
Movie
Scale
To Fit Automatically resizes the movie so that it exactly matches the size of the
container area.
Aspect Automatically resizes the movie so that it exactly matches the size of the
container area. However, the image is not stretched, but rather kept in its original proportion. For example, the width of the movie might be increased to match the width
of the container area, but extra empty space might be shown above and below the
movie in order to compensate for the height of the container area.
Value Enter the value that you want to increase the display of the movie. If you
select 2, the movie will be twice as large as 1, and so on.
Player Controls
Show Controls Select this option to show the player controls (e.g., Play, Pause).
Playback
Auto Play Select this option if you want the video to automatically begin playing when
the topic displays. Otherwise, the user must click the Play button to start the movie.
Loop Select this option if you want the movie to play repeatedly.
Audio Select the volume level for the movie.
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YOUTUBE OPTIONS
Size Specify the width and/or height in pixels or percentage.
Playback
Auto Hide Select this option if you want to hide the video's title and player controls bar
when the movie begins playing.
Auto Play Select this option if you want the video to automatically begin playing when
the topic displays. Otherwise, the user must click the Play button to start the movie.
Full Screen Select this option if you want to allow users to play the video in full-screen
mode.
Show Related Videos Select this option if you want to show similar, suggested videos
when the movie stops playing.
Annotations Select this option if you want to show annotations from the video owner
when viewing the movie.
On Enables annotations from the video owner.
Off Disables annotations from the video owner.
Appearance
Modest Branding Select this option if you want to remove the YouTube branding from
the player controls.
Show Info Select this option if you want to show the title bar on the top of the video.
Progress Bar Color Select the color you want to use for the player's progress bar.
White Displays a white progress bar.
Red Displays a red progress bar.
Controls Select the display option for the player controls (i.e., play, pause, full-screen,
settings).
On (Always) Displays player controls at all times.
On (Only during playback) Displays player controls only during video playback.
Off Disables player controls.
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Theme Select a color theme for the player controls.
Light Displays a light gray player control bar.
Dark Displays a black player control bar.
Note: Some advanced features may not work in all web browsers.

Note: Setting the Progress Bar option to White overrides the Modest Branding option, so
you will always see the YouTube logo when you play your videos.

Note: If you disable the player controls, users will only be able to play and pause the video.
They will not be able to adjust the volume, view or adjust the progress bar, change video
settings, or open the video in full-screen mode.
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VIMEO OPTIONS
Size Specify the width and/or height in pixels or percentage.
Playback
Auto Pause Select this option if you want the video to automatically pause when another
Vimeo video in the topic is played. Otherwise, the user must click the Pause button to
pause the movie.
Auto Play Select this option if you want the video to automatically begin playing when
the topic displays. Otherwise, the user must click the Play button to start the movie.
Loop Select this option if you want the movie to play repeatedly.
Appearance
Byline Select this option if you want to display the video owner's name on the movie.
Portrait Select this option if you want display the video owner's portrait on the movie.
Title Select this option if you want display the title on the video.
Controls Color If you want change the color of the player controls, click

and select a

color.
Note: Some advanced features may not work in all web browsers.

Note: If the owner of the video is a Vimeo Pro or Vimeo Plus member, some of these settings may be overridden by that member's preferences. For example, an owner of a video
may not allow you to remove the title and byline, so you will still see this information on the
video even if you chose not to display it in the Doc-To-Help output.

Note: You cannot remove the Vimeo Staff Picks badge from a video.

6. Click OK. The multimedia is added to the document, represented by code that is translated into the
video or audio when the output is generated.
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CHAPTER 8

Page Orientation in a Manual Target
A new property called "Section orientation" is now available for Manual targets. It lets you
specify a portrait or landscape configuration for pages within a given section break in a Word
document.
You can set the section configuration on a specific paragraph style or an entire Manual target.

HOW TO SET THE SECTION CONFIGURATION ON A PARAGRAPH STYLE
Setting this on a paragraph style is a good option if you need the configuration to change from portrait to
landscape within a single document. The configuration change continues in the document until it comes
across another section break.
STEPS
1. In Doc-To-Help, open the Project ribbon, and click Topic Types. The Project Styles dialog opens.
2. On the left side of the dialog, expand Paragraph Styles and select one of the styles.
Note: If you have are using a style in your source document that is not available in this dialog, click Add New Style. Then create a new style that has the same name as the style in
your document.

3. On the right side of the dialog, in the Basic section, set the Section break field to one of the following:
Next page
Even page
Odd page
4. In the Section orientation field, select one of the following:
Inherit from template This is the default option. If selected, a new section created by the
"Section break" property will have the same page orientation as that used in the template.
Portrait
Landscape
5. Click OK.
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EXA MPLE
Let's say you have a document that uses a portrait landscape throughout. However, you have inserted several wide tables in the document, and you would like the pages showing those tables to be
displayed with a landscape configuration whenever they appear in the Doc-To-Help print-based output. Like this:
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Furthermore, in your Word template you've created a special style called "TableTitle" that you apply
to a paragraph just above each table. It makes sense to associate the landscape configuration with
that paragraph style because it clearly signifies the start of the content that you want to show as
landscape.
You also insert a section break in the source document after each of those tables, because that will
tell Doc-To-Help to end the custom configuration.
In Doc-To-Help you open the Project Styles dialog. In the Paragraph Styles section on the left, you
add a new style called TableTitle, and you set the Section configuration to Landscape.

When you build the Manual target, the sections beginning with the TableTitle style are changed from
portrait to landscape.
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HOW TO SET THE SECTION CONFIGURATION ON A MANUAL TARGET
1. In Doc-To-Help, open the Home ribbon, and at the bottom of the Target group click

. The Help

Targets dialog opens.
2. On the left side of the dialog, select the Manual target.
3. In the Advanced section, set the Section break field to one of the following:
Next page
Even page
Odd page
4. In the Section orientation field, select one of the following:
Inherit from template This is the default option. If selected, a new section created by the
"Section break" property will have the same page orientation as that used in the template.
Portrait
Landscape
5. Click OK.
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CHAPTER 9

Variables—Date/Time and Version
When adding a new text variable (not a rich content variable), you can now select one of
three types: text, version, or date/time.

HOW TO CREATE A TEXT VARIABLE
1. In Doc-To-Help, select the Project ribbon.
2. Click Variables. The Variables window opens.
3. In the Text Variables area, click on the Add New Variable toolbar button.
4. Select one of the following:
Text A text variable is the type that has been used in previous versions of Doc-To-Help. This
lets you enter simple text.
Version This lets you enter a version in one of four available formats:
1
1.0
1.0.0
1.0.0.0
If you click the Build button, unchanged documents won't be processed, so variables won't
be updated in those unchanged documents when you view the output, although they will be
incremented in the Variables window where you created them.
If you want to force variables to update in all documents, you need to click Rebuild instead.
Each time you click the Rebuild button for a target that has the variable, the version values
are incremented automatically—whether the documents have changed or not—in both the
output and the Variables window.
When version variables are updated, only the last part of the number is incremented automatically.

EXA MPLE
Let's say you create a version variable with the 1.0.0 format, insert it into a document,
and build a target.
If rebuild the target, the variable changes in the output to 1.0.1.
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If you rebuild again, it changes to 1.0.2.
If the variable value reaches 1.0.9 and you rebuild, it changes to 1.0.10, then 1.0.11,
then 1.0.12, and so on.

Note: You can open the Variables window and change the variable value manually
at any time.

Note: The variable value is incremented only if this variable was used in building the
current target, so all variables that were excluded from the build process due to their
condition won't be changed.

Date/Time These variables get their values either from current system date/time, or from file
date/time attributes. This means that you cannot set its value manually (for this purpose, you
can use simple "text" type variables).
5. An editable field named "New Variable" displays in the Name cell. In the Name cell, enter a name
for the variable.
6. Depending on the variable type you selected, the Definition cell is populated with either simple text,
1.0.0.0, or a date/time format. Double-click in the Definition cell and provide the value for the variable.
Text If you double-clicked on a cell for a text variable, simply type text.
Version If you double-clicked on a cell for a version variable, enter the starting version number.
Date/Time If you double-clicked on a cell for a date/time variable, a popup displays. Complete the fields in it:
Format Specifiers This is the date/time format. You can select a format from the dropdown, or you can type a format manually. Specifiers are based on Microsoft's custom
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date and time format strings. For details of the specifiers available, see http://msdn.microsoft.com/en-us/library/8kb3ddd4.aspx.

Note: You can make a word part of the definition. For example, you might
want the word Date with a colon and a space before a date string (e.g., Date:
October 25, 2014). The issue is that certain characters are translated automatically as specifiers. So just typing the word Date wouldn't work. The easiest solution is to put the non-specifier characters within quotation marks.
Therefore, you might enter "Date:" MMMM dd, yyyy.

Update Select how you want the variable to display the date and time. You can choose
any of the following:
On Document Creation The variable displays the date and time that you created
the document.
On Document Save The variable displays the date and time that you last saved
the document.
On Build The variable displays the date and time of the most recent project build.
7. (Optional) If want to associate a condition with the variable, double-click in the Condition column
and choose a Platform, Target, or Attribute condition for the variable.
Platforms Set a platform-based condition for the variable. The text will be included in all of
the target platform(s) selected. A platform includes all the targets that produce the output specified (Online Help, HTML Help, NetHelp, Printed Manual).
Targets Set a target-based condition for the variable. The text will be included in all the targets selected.
Attributes Set an attribute-based condition for the variable. The text will be included or
excluded when creating conditional builds (e.g., internal or external). Use the Attributes dialog (Project>Attributes) to create custom attributes.
If you would like to assign more than one condition to a variable, select the variable's name and click
the Add Definition with Condition toolbar button. An additional definition row will be created.
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Enter the appropriate definition, then double-click in the Condition column to set a condition. One
text variable can have multiple unique outputs.

Tip: It is recommended that you make a different version variable for each target and then
assign conditions to those variables. This is quite useful because the version numbers are
then incremented separately for each target. On the other hand, if you create only one version variable and use it in several targets, the version number will increment after each
rebuild of any of those targets.

EXA MPLE
Let's say you have a NetHelp target and a Manual target.
In the Variables window, you create a version variable named "NetHelp" with a starting value
of 1.0. Then you create another version variable named "Manual" with a starting value of
1.26. Finally, you create a third version variable named "Shared" with a starting value of 3.9.
It would look like this:
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Next, for the NetHelp variable, you double-click the Condition cell. In the Targets field (in
the popup), you select NetHelp (or whatever your target is called).
Then, for the Manual variable, you double-click the Condition cell. In the Targets field (in
the popup), you select Manual (or whatever your target is called).
But you leave the Condition cell empty for the Shared variable. Now the Variables window
looks like this:

Next, you insert all three variables in a source Word document.
You build the NetHelp target for the first time. In the output, the variable numbers are as follows:
NetHelp 1.0
Shared 3.9
Manual Not shown because it was conditioned out
Now you build the Manual target for the first time. In the output, the variable numbers are as
follows:
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Manual 1.26
Shared 3.10
NetHelp Not shown because it was conditioned out
Next, you rebuild the NetHelp target. In the output, the variable numbers are as follows:
NetHelp 1.1
Shared 3.11
Manual Not shown because it was conditioned out
Finally, you rebuild the Manual target. In the output, the variable numbers are as follows:
Manual 1.27
Shared 3.12
NetHelp Not shown because it was conditioned out

Note: All variables in existing projects remain unchanged and use the "text" variable type.

Note: After creating a variable you cannot change its type.

CHAPTER 9│What's New Guide
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CHAPTER 10

Removal of Features
The following features have been removed from Doc-To-Help:
Getting Started Wizard Removed
HTML5 Editing Removed Starting with Doc-To-Help 3, you can only create new
Microsoft Word source documents; you cannot create new HTML5 documents. In addition, you cannot edit HTML5 files within Doc-To-Help.
These changes help to simplify Doc-To-Help, making it an authoring tool that is primarily dedicated to those who prefer to author in Word. However, if you have legacy DocTo-Help projects, your HTML5 and CSS files will continue to be supported. Also, you
still have the ability to select, add, edit, and remove CSS files from those projects. You
can do this from the Help Targets dialog or Project Settings dialog, rather than the
Home ribbon. If you prefer to use a tool where you can edit and work with HTML files,
you might consider converting to MadCap Flare.
See http://www.madcapsoftware.com.
NetHelp Classic Removed The older NetHelp Classic option is no longer available.
In Doc-To-Help, the word "NetHelp" now refers exclusively to what had been called
NetHelp 2.0 previously.
WinHelp Removed The WinHelp target type is one of the oldest output formats, is
rarely used by most content developers, and therefore has been removed.

Word 2003 Support Removed Doc-To-Help no longer supports Word 2003 (and older versions).
To launch Doc-To-Help, you must have Word 2007 or newer.
Doc-To-Help no longer provides templates for Word 2003 or lower, but they are still available in the
default Word user's template folder (if previously installed).
You are still able to use DOC and DOT (old Word files format) files in Doc-To-Help projects. Also,
you can still build Printed Manual targets in DOC format.
Finally, the value "Word 2000 only" has been removed from the "Fix numbered lists" property for
Manual targets.
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APPENDIX

PDF Guides
The following PDF guides are available for download from the online Help.
On the Doc-To-Help Start Page, click the PDF Guides icon to access them.
Context-sensitive Help Guide

Sandcastle Guide

Documents, Templates, and Content Guide

Shortcuts Guide

Getting Started Guide

Targets Guide

Making It Look Good Guide

Touring the Workspace Guide

Managing Your Project Guide

Upgrading Old Projects Guide

New User Tutorial Guide

What's New Guide

